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Safety Precautions 
 

Read the instruction manuals for all relevant equipment carefully before 
starting to use ClimaCheck Performance Analysing systems. 
 
ClimaCheck PA Pro III is a measuring and analysing system developed to give 

detailed evaluation of refrigeration, air-conditioning and heat-pump systems in 
development laboratories, production tests and in the field. 
 

If equipment is used in a way not specified by producer the protection and safety provided may be 
impaired. 
 
Certifications/licenses are required in most countries for activities related to electrical systems, 

pressurised systems and systems charged with refrigerants that have environmental impacts 
and/or flammability. 
 

ClimaCheck products are only intended for use by competent technicians/engineers complying with 
local requirements for certifications/licenses. 
 
Any work with electricity, pressurised systems or refrigerant involves potential dangers to human 

health and system integrity if not conducted with caution. Always inspect the equipment for 
damaged cables or other components before use. For many installations loss of product or 
disturbances in operation incurs high costs. ClimaCheck assumes no responsibility for injuries or 
costs that may occur as a result of failures in connection with measurements. The user must 
evaluate whether an inspection can be carried out without risk of injury and/or damage. 
Measurements should only be carried out when it can be done under safe working conditions and 

without risks. 
 
 
 

Note - additional manuals 
 

Detailed Manuals for Hardware and Software is available under Help menu in 

ClimaCheck software. 

 

These pdf files can also be found under the program files directory where 

ClimaCheck is installed. Path can be slightly different in different versions of 

Windows but typically program files\climacheck\help. 
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ClimaCheck Quick Guide 

 

Figure 1 

 

• Connect ClimaCheck PA Pro III to your PC with a USB cable.  
• Start ClimaCheck Standard software from the desktop or the program menu. 
• Enter the system information.  

• Verify that correct Refrigerant is selected. If wrong, change under Refrigerant menu in 
toolbar. 

• Select File > Save ClimaCheck Work Book and give the file a name.  
• Select Contact > Direct to activate the connection to PA Pro III.  
• Select desired scan interval. Select Start under Scanning in the toolbar. 
• Check the sensors against atmosphere pressure and room temperature. 
• Attach all temperature sensors with heat transfer paste, aluminium tape and insulation. 

• Attach pressure sensors (check for correct pressure range). 
• Always attach cables between current clamps and Power meter, before 

connecting the current clamps around the voltage wires. Check that the arrow on 
the clamp points to the compressor.  

• Press Clean up button in toolbar to clear from old values. 
• Adjust system/load for stable operation. 
• Check sub-cooling, superheat, compressor efficiency.  

• Check for stability and possibility to optimise. 

• Select File > Save ClimaCheck Workbook to save your results. 
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Sensor application validation at start-up 
 
 

Input Sensor Logical check 
OK/ 

not OK 

NX400,1 High 
pressure 
sensor e.g. 

condensing 
temperature 

The condensing pressure is converted to condensing temperature 
in the software based on chosen refrigerant. For manual control 
use gauges/refrigerant “slides” or tables. 

If the system has fixed installed gauges/sensors compare value in 
ClimaCheck with gauges/sensors or service manifold.  

If no second meters are available check the condensing 
temperature versus specified or expected. This should typically be 
slightly above exiting air/water of condenser. 

If not correct, check that the right sensor is used (standard is 35 
bar(g) otherwise configuration must be changed), correct 

refrigerant selected and if values are more or less fixed, check that 
Schrader or service valve is properly open.  

 

NX400,2 Low pressure 
sensor e.g. 
evaporation 
temperature 

The evaporation pressure is converted evaporation temperature 
in the software based on chosen refrigerant. 

If the system has any fixed installed gauges/sensors compare 
value in ClimaCheck with gauges/sensors or service manifold. 

If no second meters are available check the evaporation 

temperature versus specified or expected. This should typically be 
slightly below exiting air/water of condenser. 

If not correct, check that the right sensor is used (standard is 10 
bar(g) otherwise configuration must be changed), correct 
refrigerant selected and if values are more or less fixed, check 
that Schrader or service valve is properly open. 

 

R560,20,1 Discharge 
temperature 

The discharge temperature is strongly dependent on operating 
conditions. To identify if this value is realistic either check with 

independent sensor/control system or check if compressor 

efficiency is realistic (typically 55-75% for semi- or hermetic 
compressors). If discharge is low and high efficiency is indicated, 
check that sensor is well applied and no sensors have been 
switched also check that there is super heat as liquid in the 
suction line will result in low discharge and high efficiency. 

 

R560,20,2 Suction 
temperature 

The suction temperature is normally slightly above evaporation = 
the superheat. This is dependent on the expansion valve setting, 

suction line’s temperature, length and insulation. Too low 
superheat might indicate liquid carry over or excessive oil 
transport. Check sensor, application if this value is not as 
expected. 

 

R560,20,3 Liquid temp. The temperature is normally slightly below the condensing. This is 
dependent on the type of and distance to condenser and if there 
is a receiver as the sub-cool = 0 in the receiver.  Check sensor, 
application and pressure drop if this value is not as expected. 

 

EP,1 Power input Check that currents are correctly measured and agree with rated 
currents of motor/compressor. Fans and pumps should not be 
included. Check power factor and voltage on meter. If any 
currents are negative or uneven, power factor not between 0.70 
and 0.95, caution should be taken to ensure correct connection. If 
magnitude of currents or other values are not correct check 
connection and ratio setting for clamps.  
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1 Introduction 

1.1 ClimaCheck1 
ClimaCheck is a measuring and analyzing system developed to give detailed evaluation of 
refrigeration, air-conditioning and heat-pump systems in development laboratories, production 
tests and in the field.  
 
The method is based on measurements in the refrigeration circuit and does not require any fixed 
installation of metering equipment in the system. The advantages of easy connection, immediate 
and detailed information makes the ClimaCheck method superior for evaluating all refrigeration, 

air-conditioning and heat pump systems. 
 
An increased focus on energy efficiency can be seen in the EU Directive 2002/91/Ec on 
the Energy Performance of Building and several other requirements on energy 
performance on other markets. This directive requires annual inspections with 
verifications of energy efficiency of all AC systems with more that 12 kW rated capacity. 

Measuring with ClimaCheck gives and excellent foundation for performance inspections. 
 
The ClimaCheck Performance Analysing method allows complete analysis of energy performance 
as well as presenting all information to validate the individual components and their optimization 
without the requirement of any fixed equipment making it possible to immediately identify and 
locate any deficiencies in the system. The method was patented in 1986 and has since been used 
in Sweden and internationally in the Product ETM 1500, ETM 2000, ClimaCheck PA 8:7 and now 

ClimaCheck PA Pro. 
 
The PC based evaluation software that can be used with direct or remote connection to the data 
logging device utilizes a modern spreadsheet interface and the globally accepted equations for 
refrigerant properties in RefProp established by NIST (National Institute of Standards and 
Technologies in USA).  
 

The use of standard “templates” tailored to give a comprehensive evaluation of anything from a 
simple air-conditioning split to a complex industrial refrigeration plant new era in refrigeration 
service. The operator does not need know-how of the calculations. Users with advanced 

refrigeration competence can develop their own templates for any specific need. 
 
ClimaCheck contains functions to store and print reports including data and graphs and there is 

also an export to Excel feature for further processing of data.  
 
The ClimaCheck method is suitable for almost all compressor based refrigeration processes. All 
suction or discharge gas cooled hermetic and semi hermetic compressors can be fully evaluated 
without any compressor or system specific information. For open compressors the electrical motor 
efficiency is given as input and for compressors with external cooling of air, water, oil or liquid 
injection information on the cooling need to be entered to give a full capacity and COP accuracy. 

For many types of systems data on compressor cooling are well known and necessary parameters 
are known. ClimaCheck Specialists should be consulted to give advice on non-standard systems. 
 
For in depth information please refer to ClimaCheck Help under the Help menu in the ClimaCheck 
Software or the Help folder in the ClimaCheck on your PC. These contains documents with detailed 
information about ClimaCheck software and hardware. 
 

1.2 ClimaCheck license 
ClimaCheck software is sold as a one-computer license and each installation will require a 

registration key from ClimaCheck. Please contact ClimaCheck for special offers on additional 
licenses within the same organization. 

 
1 ClimaCheck is a registered trademark. 

http://www.climnet.org/EUenergy/EnergyPerformanceBuildings.pdf
http://www.climnet.org/EUenergy/EnergyPerformanceBuildings.pdf
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1.3 Technical Specification PA Pro III 
Inputs on main board: 4 x Analogue (0...10V or 4...20mA). Accuracy ±0.5% FS 
 1-wire temperature bus (-25 to 150°C). Accuracy ±0.5K (-20 to 80°C)  
 8 x Digital (wired to front) 
Outputs: 8 x high-power solid-state Digital (2 wired to front) 
Analogue input module: 8 x inputs configurable Pt1000, 0-10 V, 4-20 mA 
 Accuracy Temperature input ± 0.25°C, Analogue ±0.1% FS 
Modem: Penta-band cellular modem, UMTS/HSPA 

Communication: Ethernet, WiFi, RS485x2, RS232x2, USB, Bluetooth classic/LE, CAN2.0B 
Memory: SD-card 
Supply voltage:  24 VDC, 10W 
Dimensions: 501 x 279 x 193 mm 
Weight: 11 kg 
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2 Handling and safety 
- The PA Pro III should only be supplied with CE/UL/CSA approved 24 volt direct current 

power supply supplied by ClimaCheck. The centre of the plug should have positive polarity. 
The current supply should not exceed 1 A. The mains supply voltage should be at least 
100-240 VAC. 
 

- Always place the equipment in a way ensuring that power can easily be disconnected if 
needed. 

 
- Operating temperature range for the PA Pro III is -5 to +60 °C. Operating temperature 

range for the included power supply is 0 to +40 °C. 
 

- Operating humidity is R.H. 5 – 90 % non-condensing. 

 
- Maximum operating altitude: 2000 m. 

 

- The equipment is designed for a maximum of Pollution Degree 2. 
 

- The equipment should not be used in wet location. 
 

- Always inspect the equipment for damaged cables or other components before use. If 
needed clean with a soft towel moistened with water and a mild detergent. 

 
- The equipment enclosures have not been tested for UV-resistance and are thus not 

approved for outdoor use. 
 

- The fuse on 24VDC s of the PA Pro should be 20x5 mm of the type T 1 A L, 250 V. Use 
only UL/CSA approved fuses. 

  
- See Section 4 for important safety instructions when using the power meter EP Pro. 
 
- If the instructions in this section and the rest of the manual are not observed, the 

protection provided by the equipment may be impaired. 

  



 

Field Manual PA Pro III – 2021-07-08  Page 10(37) 
 

3 Connectors overview 

 

Figure 2 

 

 

Network socket.  

USB USB Type B socket. Use the supplied USB cable to connect directly to a PC. 

24 V DC 24 V DC power supply. Use only approved 24 V DC supply with a maximum 
output of 1 A. Centre of connector should have positive polarity. 

Fuse Holder for 20x5 mm fuse of type T 1 A L, 250 V. 
RS-485 Serial cable connection for EP Scout power meter and other external units. 

Also supplies 24 V DC. Two serial cables of different length are supplied as 
standard. 

R560,20,1 to 

R560,20,8 

3.5 mm sockets for Pt1000 sensors. The system is configured with a 0.35 K 

offset to compensate for the cables of the included sensors. 

NX400,1 to 
NX400,4 

Sockets for analogue connectors 1-10 V or 4-20 mA. Supplies 24 V DC. The 
two included pressure sensors are connected to Al_1 and Al_2. 

1-wire 3.5 mm sockets for 1-wire temperature sensors. 

DI/DO Socket for digital inputs and outputs. Not used as standard. Compatible plug 
available at request. 

 
For connectors on ClimaCheck power meters please refer to the corresponding manuals. 
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4 Connection of power measurement 
 

Important! 

 
Improper use of ClimaCheck power meters may cause high voltage build up that can be 
dangerous both for equipment and operators. Adhere to the practices below to avoid 
this, always refer to ClimaCheck EP Pro manual, and: 

 
 

- Always connect the current clamps to the power meter (EP Pro) before they are 
attached around a live wire. 
 

- Always remove the current clamps from the live wire before the cables to the 
power meter are disconnected. 

 
- Incorrect connection of voltage between phase and neutral will damage the 

equipment. 
 

- Never use the current clamps on uninsulated wires or rails. 
 

In addition follow the steps below to assure proper power and energy readings:  

 
- It is important to only measure the power to the compressor. Make sure the measurement 

is done after the point where circulation pumps and fans are connected. 
 

- Make sure that the voltage and current for each phase corresponds with the markings on 
the measuring equipment and that the arrow on the current clamps are pointing in the 

direction of the current.  
 

- Make sure that the current clamps are completely closed and that the contact areas are 
clean. 

 
- Check that the connections are correct by reading the voltage, current and power on the 

display of the power meter. If you find a problem remove the clamps and attach L1 

followed by a control and the repeat the process for L2 and L3. 
 
When the ClimaCheck EP Pro II is connected to a powered up ClimaCheck PA Pro III it is not 
necessary to connect it to a separate power supply. The unit will be powered over the serial cable. 
A separate power supply is only necessary when using the meter on its own. In advanced 
applications with several power meters or long serial cables it may be necessary to connect a 
second power supply to ensure sufficient power. 

 
For more information about the ClimaCheck EP Pro II, see section ClimaCheck EP Pro II Manual. 
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5 Electrical Drawing 

 

Figure 3 
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6 Connection of sensors 
Sensors should be placed in accordance with each template. All sensors should be checked against 
room temperature and atmospheric pressure before being attached. If you have never worked with 
your ClimaCheck, assemble the entire system including software at the office to minimize the 
number of problems in the field. 

6.1 Mounting of pressure transmitters/transducers 
Pressure should be registered as close as possible to the compressor inlet and outlet. Pressure drop 
between sensor and compressor will affect the accuracy. 
 

The AI channels are pre-configured as below: 
- NX400,1: 35Bar, 0-10V 
- NX400,2: 10Bar, 0-10V 
- NX400,3: 35Bar, 0-10V 

- NX400,4: 10Bar, 0-10V 

6.2 Mounting of temperature sensors 
Temperature sensors may be mounted on the outside of piping with the ClimaCheck method due to 
the inherent low sensitivity to temperature errors. This is a critical advantage compared to 
traditional methods but should not be taken as an excuse to not follow the recommended 

procedures below.  
 
Temperature sensors should be mounted: 
 

- 10-20 cm from the compressor, flanges, valves or other objects that can act change the 
surface temperature compared to the inner temperature of the tube. 

 
- Maximum contact should be ensured by: 

▪ Removal of any insulation and paint on the tube. 
▪ When mounted in pockets the sensor must be securely pressed against the wall of 

the pocket.  
▪ Heat transfer paste should always be used for surface and “pocket” mounted 

sensors. 

 
- Aluminium tape should always be used for surface mounting. 

 
- Insulation should be carefully done and diffusion tight if the surface/object is cold. The 

openings of dip tubes/pockets should be sealed/covered with insulation. 
 
 

 

 

Figure 4 - Apply sensors with heat transfer compound, Aluminium and insulation 
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6.2.1 Required insulation 

Many factors have an impact on required insulation to achieve good accuracy: 
 

- dT to ambient 

High dT obviously increases the error from poor insulation. 
 

- Radiation from surrounding hot/cold surfaces. 
 

- Material type in tube 
Good heat transfer decreases the error caused by the wall from best to worse copper - iron 

- stainless – plastic. 
 

- Material thickness in tube 
Dimension, pressure and material define thickness thicker tube wall increase need of 
insulation. 
 

- Condensation 

It is important to avoid condensation on or near sensor as this will have a significant impact 
on temperature reading. 
 

- Ice formation 
If ice is allowed to form around sensors (condensation on cold tubes) this creates an 
insulation. 

 

Importance of accuracy 
 
A service check can allow a higher tolerance for errors than an inspection to validate that 
performance is according to contract. 
 
Note that even if temperatures on secondary side do not have any impact on capacity and COP of 

refrigeration process, they will, if nominal data is taken from manufacturers, strongly impact these 
reference data. 
 
We advise common sense to be applied, with special attention to discharge and suction line sensor 

on the refrigerant side due to high dT and risk of condensation. 
 
For best accuracy, remove dirt, paint and corrosion, and avoid pushing sensors inside existing 

insulation - cut a hole in insulation instead. Always use heat transfer paste and aluminium tape to 
make insulation on cold tubes so that condensation or ice formation cannot take place on sensor. 
 
Smaller size copper tube  minimum 60 mm x 8 mm tight insulation pressed against 

tube (thickness 8 mm or 3 turns of insulation tape) 
 
Larger size CU (> 35 mm/1.5") minimum 100 mm x 8 mm tight insulation pressed against 

tube (thickness 8 mm or 3 turns of insulation tape) 
 
Steel/plastic/stainless piping   minimum 15 cm x 8 mm insulation 

6.2.2 Compensating for changes in Pt1000 temperature sensor cable 
length 

No configuration has to be made if using the entire white 5 m cable, or the entire red 10 m cable, 
of a Pt1000 temperature sensor. If a cable is shortened or lengthened the change in resistance 
needs to be compensated for. The offset needs to be increased for a longer cable or decreased 
for a shorter cable. The white cable got a resistance of 0.07 K/m and the red cable 0.035 K/m 
(using all four leads in pairs). 

 
For temporary compensation when using temperature sensor cable extensions, see Section 11.9. 
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6.2.3 1-wire temperature sensors 

A 1-Wire temperature sensor is a bus sensor and unlike Pt1000 sensors the measured value of the 
sensor is not affected by the resistance in the cable between the master (PA Pro III) and the slave 
(sensor). Limitations in number of sensors and cable length as well as the preferred topology is 

described below. 
-  

ClimaCheck 
1-wire master

concom
PA Pro III

Split
(+0.5 m)

Split
(+0.5 m)

< X m

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

< 3 m
<3 m

< 3 m

< X m

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

< 3 m

< 3 m

Split
(+0.5 m)

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

< 3 m

<3 m

< 3 m

< X m
Split

(+0.5 m)

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

1-wire sensor
(+0.5  m)

< 3 m

<3 m

< 3 m

< X m

1-wire bus

Stub

i.e. cold room, 
Heating system, 

chilled water

i.e. missing unit 
temperatures

 

Figure 5 1-Wire preferred topology 

 
The preferred topology, Figure 5, is with the PA Pro III connected at one end of the 1-Wire bus and 
each sensor connected to the bus with branches or “stubs” where each stub is less than 3m. The PA 

Pro III can handle a total of 16 sensors and a total “weight” of 65 m. The weight is the length of all 
cables + 0.5m per sensor + 0.5m per split. 
 
Weight = total cable length + 0.5*sensor + 0.5*split 
Example: 3 sensors on 2 meter stubs that is located 5 meters from the PA Pro III with 1 split has a 
total weight of 0.5*3+(2*3+5)+0.5*1=14.   

 
Do not run signal wires in parallel with power cables. 

6.3 Connection of power meter 
Follow Section 4 for instructions on how to connect the power measurement. 
  
To connect the ClimaCheck power meters to the ClimaCheck PA Pro III, use the provided serial 
cable. Attach one end to the power meter RS485 port and the other end to the PA Pro III RS485 
port. Multiple power meters and other Modbus external units, such as a portable R560, can be 
connected in series with the provided serial cables. 

 
The power meter can be used to measure the following electrical systems: 

• 3-phase with zero 
• 3-phase without zero 
• 2-phase 
• 1-phase 

 

The current transformers and the voltage cables should be connected according to the electrical 
system diagrams below. 
 
Always do a phase verification after connection, as described below. 
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6.3.1 CT and voltage connections of PowerScout 3HD 

 
3-phase with zero 3-phase without zero 

  

2-phase 1-phase 

 

 

Figure 6 

 
To do a phase verification, scroll the side button on the PowerScout 3HD until the display shows 
PFCheck. All measured phases should show OK. If a phase shows Bad, double check the 
connection and make sure each CT and corresponding voltage cable are measuring matching 
phases. 
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6.3.2 CT and voltage connections of EP Pro Scout 

 
3-phase with zero 3-phase without zero 

  

2-phase 1-phase 

 

 

Figure 7 

 
To do a phase verification, look at the CT1, CT2, CT3 LEDs on the EP Pro Scout. All measured 

phases should show green. If a phase shows red, double check the connection and make sure 
each CT and corresponding voltage cable are measuring matching phases. 

6.4 Checking sensor readings  
Before starting to analyse the setup the feasibility of all sensor readings should be checked. This is 
easiest to do under the Input tab. Incorrectly attached, mixed up or defect sensors will make it 
impossible to conduct a correct assessment of the refrigeration process. 
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7 Validation of measuring system 
All measurement systems are dependent on good upkeep of measuring equipment and on operator 
not taking shortcuts when performing a performance and/or function control. ClimaCheck is 
designed to give the operator an easy to use system without requiring the operator to have 
detailed knowledge of the thermodynamic calculation method. It is recommended to check that 
sensors present the correct and expected values otherwise testing may have to be repeated due to 

uncertainty of input data. 
 
National guidelines and sensor suppliers recommended calibration routines should be strictly 
followed and documented. 
 
Simple controls can easily be done and are strongly recommended for each occasion the equipment 
is applied i.e.: 

 
- Verify pressure transducers against atmospheric pressure, normally around 101 kPa(a). 

The low pressure transducer should be close to this (with allowance for atmospheric and 

altitude variations). The higher the range of the pressure transducer is the larger deviation 
in kPa is within tolerance. Sensors should be well within supplier specification before it is 
applied (1% of full scale is recommended maximum tolerance e.g. 10 kPa deviation for a 
10 Bar(g) sensor see sensor specifications). Calibrations of offset can easily be done in 

ClimaCheck or logger depending on system. 
 

- Temperature sensors should be connected before that they are applied to verify that they 
show the same or very similar values. The accuracy will be improved if the control is done 
with all sensors in water that is stirred. Recommended quality specification of temperature 
sensors are Pt1000 class A (approximately 0.15 K tolerance see sensor specification). 

 
- Power transducers should display zero when current clamps are disconnected from lines. 

When in operation power should always be checked against name plate/catalogue data to 
identify any bad connections or malfunctions.  

 
Any unexpected differences should be corrected before sensors are applied. 
 

Calibration of all sensors should be done regularly according to routines set up by the user of the 
equipment. Calibration is normally done with known references (ice water or boiling water) and 
with accurate instruments that are regularly calibrated. 

7.1 Locking the case when measuring 
The ClimaCheck case has a removable panel in the middle of its long edge. This allows you to keep 
all sensors connected and still closing the lid. If needed the case can be secured with a pad lock, 
making sure no one tampers with the equipment when left unattended. 
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8 ClimaCheck PA Pro III Hardware 
This section describes the ClimaCheck PA Pro III hardware. For more detailed information, please 
refer to the PA Pro III Hardware Manual. 

8.1 LED indicators 
The ClimaCheck PA Pro III has 4 LED indicators: 

- A: ClimaCheck online 
- B: 1-wire / Modbus 
- S1: Status 
- S2: Modem 

 
The A LED indicates the status on contact with ClimaCheck online server. 

- A Led (CC Online) - Status 

 
900ms on, 

900ms off 

Connection with ClimaCheck Online OK (Normal operation with internet 

connection) 

 Off 
No connection with ClimaCheck Online (Normal operation without 
internet connection) 

 Fast blinking Unsuccessful to send data to ClimaCheck Online 

 
The B LED indicates the status of 1-wire and Modbus communication. 

- B LED (1W/Modbus) - Status 

 
900ms on, 
900ms off 

All configured Modbus and 1-wire units OK (Normal operation) 

 
400ms on, 
400ms off 

Modbus communication error 

 
Continuous on, 
off 

1-wire communication error 

 
The S1 LED indicates the status on the PA Pro program. 

- S1 LED (Status) - Status 

 
500ms on, 

500ms off 
PA Pro application running OK (Normal operation) 

 
1500ms on, 
500ms off 

PA Pro application running OK, while charging the internal back-up 
battery. 

 
500ms on, 

500ms off 

PA Pro application running OK, while connected to ClimaCheck 

software (Normal operation, while connected to software) 

 Fast blinking 
The unit has been forced into recovery mode with the use of the system 
switch. The application is not executing. 

 Fastest blinking The unit is initializing, preparing to start the application. 

 
75ms on,   
925ms off 

Execution speed is different from full-speed. 

 Fast blinking 
A runtime error has been detected in the program, contact ClimaCheck 
support 

 
Alternating 

Fast/Slow 
The unit has lost its firmware, contact ClimaCheck support 

 
The S2 LED indicates the modem status.  
Communication status is showed as an icon in the display and with the S2 LED, see table below. 

- S2 LED (Modem) - Status 

 Off The GSM module is turned off. 

 
600ms on, 
600ms off  

No SIM card inserted or no PIN code entered, or network search in 
progress, or ongoing user authentication, or network logon in progress. 

 
Single 75ms on, 
3s off  

Logged to the network, no call in progress. 

 
Double 75ms on 
3s Off  

A GPRS session is active. Bars indicate signal strength 

 Flashing  Indicates GPRS data transfer. 
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8.2 Start 
ClimaCheck PA Pro starts directly when it is connected to the power supply. During start, a choice 
can be made to connect to ClimaCheck online or run offline measurements on the PC software. 
When the PA Pro asks Connect to PC? Press Yes to run offline measurements or No to connect to 
ClimaCheck online. 
 
When the system is used offline the display shows ClimaCheck PA Pro III, the 6 digit ID, and the 
application version, after around half a minute, The unit can now be used. 

 
If the system is connected to ClimaCheck Online with GPRS, LAN or Wifi the unit will try to connect 
to internet and send data. To change network interface, select Network interface from the menu. 
Check Section 8.3 for the correct location. 
 
To reboot the unit, select Restart/Reboot from the menu. Check Section 8.3 for the correct 
location. 

 

The unit can be turned off by disconnecting the power. The internal backup battery allows for a 
safe shut down. 
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8.3 Menus 
There are 8 push buttons on the PA Pro touch screen. To open the main menu, press Esc. To open 
a sub menu, press SEL. To choose a function or confirm a configuration, press OK. To go back, 
press ESC. The menu structure is shown in the figure below. 
 

 

Figure 8 Menu structure 
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8.4 Monitor 
All values from sensors and power meters can be seen under the Monitor menu. From the Monitor 
menu, the send interval to ClimaCheck online can also, temporarily, be changed. 

8.4.1 View all values 

To view all values: 
- Press ESC to enter the Main menu 

- Press Down until “Monitor” is shown in the display  
- Press SEL to enter Monitor menu  
- “Show values” appears in the display 
- Press OK 

 
Values are shown with a sensor/value number, a comment/description, the sensor reading, and a 
unit. Press Up/Down to step through the list of values.  

8.4.2 Signal level 

When using the PA Pro III with GRPS modem or Wifi, it is possible to check the signal level. 
- Press ESC to enter the Main menu 
- Press Down until “Monitor” is shown in the display  
- Press SEL to enter Monitor menu  

- Press down until “Signal Level” is shown in the display 
- Press OK 

8.4.3 IO Devices 

The Show IO Devices menu shows the configured devices including the analog inputs and the 
Modbus units such as R560 and EP Scout. The menu shows if any of the devices are disabled 

because of communication errors. To reactivate all units, restart the PA Pro III. 

8.5 Configuring 1-wire sensors 
1-Wire sensors delivered with the system/logger will be configured and marked at shipment. Sensors 
added later have to be configured/connected.   

8.5.1 Connecting sensors 

The sensors need to be connected and configured one at a time. Use the following sequence to 
setup and connect the sensors: 

 
- Press ESC to enter the Main menu 
- Press Down until “Setup” is shown in the display  
- Press SEL to enter setup menu  
- “1W Sensor Setup” appears in the display  
- Press OK to start setup  

 

If this is the first setup, “T1 Sensor not conf” appears in the display. If sensors are already 
configured, they will be listed.  

 
- With the up and down arrows go to the position you want to save a sensor to 
- Press SEL 
- “TX NEW=xxxxxx OK” is shown in the display, where TX is the position and xxxxxx is the ID 

number of the sensor 

- Confirm with OK, “S-RID Saved” appears for 2 seconds 
- Temperature reading and ID appears in the display “TX=XX.X ID=xxxxxx”  
- Press up/down to continue with the next sensor or ESC 4 times to go back to the main menu. 

 
If “No new s-r found” appears while setting up a new sensor, the PA Pro cannot find any sensor on 
the bus that is not already configured. Check the connection and make sure the sensor has not 

been configured already. 
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8.5.2 Replace a 1-wire senor 

To replace a 1-wire sensor: 
- Disconnect old sensor   
- Press ESC to enter the Main menu 

- Press Down until “Setup” is shown in the display  
- Press SEL to enter setup menu  
- “1W Sensor Setup” appears in the display  
- Press OK 
- Select the sensor number in the list, it will say “Sensor missing”.  
- Connect new sensor and press SEL,  

- “Tx NEW=xxxxxx OK” is shown in the display 
- Confirm with OK, “S-RID Saved” appears for 2 seconds 
- Temperature reading and ID appears in the display “TX=XX.X ID=xxxxxx” 
- Press ESC 4 times to go back to the main menu. 

8.5.3 Clear all 1-wire sensors 

To clear all configured 1-wire sensors: 
- Press ESC to enter the Main menu 
- Press Down until “Setup” is shown in the display  
- Press SEL to enter setup menu  
- Press down until “Clear 1W Sensors” is shown in the display 
- Press OK 
- “Clearing..” appears and then you’re back in the setup menu 

 
This will clear all 1-wire sensors including any preconfigured 1-wire sensors. You can now connect 
the sensors again, see Section 8.5.1. 

8.5.4 Troubleshoot 1-wire sensors 

Below are the possible error messages when connecting a 1-wire sensor. 

 
“No tempsensors or conn. Wrong. OK?” 
Check wiring and make sure all sensors are connected properly. If the wires from one sensor is 
mixed up, the whole 1-Wire bus stops. 

 
“No new s-r found” 
Check wiring and make sure sensor is not already connected/configured on a different position. 

 

8.6 Data to different processes on ClimaCheck online 
When sending data to ClimaCheck online, it is possible to choose which process the data should be 
sent to. This is done by checking the process ID on ClimaCheck online and choosing it from the PA 
Pro III display. The ID consists of the PA Pro III serial number and a suffix such as @1 or #1. From 
the Setup menu, choose Select ID Suffix and select the corresponding suffix. 
 

8.7 Network interface 
The PA Pro III can connect to ClimaCheck online through GPRS modem, LAN and Wifi. To choose 
the method of connection, go to the Network Setup menu, select Network interface and select 

the corresponding network. 

 
If the PA Pro III is in PC/Offline mode, it still is possible to connect to ClimaCheck online by going 
to the Network Setup menu, selecting Online in PCMode and pressing Yes. The PA Pro III will 
then try to connect to ClimaCheck online through the selected network interface. 
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8.8 Log to USB 
Data can be saved to a USB memory connected to the USB-port on the top side of the unit. Data is 
saved with the same interval that is used to send data to the ClimaCheck Online server i.e. once 
every minute when the compressor is running and every 5 minutes when it’s off. The USB memory 
needs to be formatted with the file system FAT or FAT32.  
To activate logging to USB: 
 

- Shut off logger by disconnecting power 

- Connect the USB memory to the USB-A port on the top side of the unit.  
- Start logger by connecting power again. Wait for the unit to start. 
- Press ESC to enter the Main menu 
- Press down until “USB/Backup” appears in the display 
- Press SEL to enter USB/Backup menu 
- “Log data to USB” appears in the display  
- Press SEL to enter the menu,  

- Press Yes and then confirm with OK 

 

A folder is created on the USB memory with the PAID as name and the data is saved in *.LOG files 
as comma separated values. A new file is created for each day and when the USB memory is full 
the logging stops. 

 
For instructions on how to run *.LOG files in the ClimaCheck software please see the ClimaCheck 
Software manual.  
 

 

Figure 9 USB memory with data from two different Gateways 

 
To deactivate logging to USB:  

- Press ESC to enter the Main menu 
- Press down until “USB/Backup” appears in the display 
- Press SEL to enter USB/Backup menu 

- “Logg data to USB” appears in the display  
- Press SEL to enter the menu,  
- Press No and then confirm with OK 

8.9 Backup and restore configuration 
It’s possible to backup and restore the device configuration through the PA Pro III display. To 

backup the configuration, go to Data/Config. Backup menu, select Backup/Restore Config and 
select Backup Config Intern. This will save the configuration file in the internal memory. To 
restore the configuration, go to Data/Config. Backup menu, select Backup/Restore Config and 
select Restore Config Intern. 
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9 ClimaCheck software with PA Pro III 
The following section describes the integration of the ClimaCheck software with PA Pro III. 

9.1 Installing the ClimaCheck Software 
When installing the ClimaCheck software make sure to follow these guidelines: 
 

- Log in as an administrator. 
- Have a working internet connection for registration. 
- Install the software at the office to minimize the risk of problems at the site of 

measurement. 

- The license number can be found on a copy of the delivery note attached at the end of this 
manual. 

9.2 Connecting to PA Pro III 
To connect the ClimaCheck software to PA Pro III and start the measurement, follow the steps 
below: 

- Start the PA Pro III. Check Section 8.2 for more details. 
- Connect the provided USB A to B cable to the PA Pro III and the PC. 
- Start ClimaCheck Standard. A reminder of the refrigerant will be shown. 
- Press contact and choose Direct on menu. 

 

 

Figure 10 

 
It is possible to get the question “The channel names in this datasource are not the same as in the 
connected PA Pro or in the loaded PA Pro logfile. Connect anyway?”. This means that the PA Pro 
does not currently use the exact same names for its data channels as the software does. This 
results from the hardware and software not being updated at the same time, or that either the 

hardware or the software got custom configurations. In either case, just click Yes to continue. The 
next window shows “Do you want to update the datasource with the channel names from the 
connected PA Pro or loaded PA Pro logfile?”. Click Yes here as well. 
 
To not get this question on every start, make sure to save the updated datasource: 

• Select Settings -> Preferences from the menu. 
• Check the box Advanced mode and click OK. 

• Select File -> Save Datasource changes from the menu. 
• Disable advanced mode again to hide the extra options it enables. 

9.3 Troubleshooting the connection 
If you have problems getting contact with the PA Pro try the following: 
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- Make sure the USB cable is connected properly. 
 

- Make sure the correct data source is chosen under Settings > Preferences > Common > 
Default DataSource. The default should PA_Pro_III_Standard.ccd. 
 

- Restart the program. 

  



 

Field Manual PA Pro III – 2021-07-08  Page 27(37) 
 

10 PA Pro III configuration 
The chapter describes how to use the PA Pro III configurator. For more detailed information, please 
refer to the Hardware Manual. 
 
The PA Pro III Configuration tool can be found under the PA Pro III menu in the ClimaCheck 
software. 

 
 

 

Figure 11 

All ClimaCheck PA Pro III systems have their default configuration on the ClimaCheck Online server 

but with the configurator, settings can be changed without the need of an internet connection.   
 
To exit the configurator, go to File menu and then Exit. The configurator will be stopped and the 
ClimaCheck software is opened again.    

 

10.1  Edit PA Pro III input configuration 

 

Figure 12 IO Config Edit tab with 4 external units 

The analog inputs on the PA Pro III unit and Domat R560 module can be used for different 0-10V 
and 4-20mA sensors. To change the configuration, follow the steps below.  

- Go to PAPro III menu and PA Pro III Configuration 
- On the Action menu choose Connect to Device, in the lower right corner the PAID of the 

connected device can be seen.  
- On the Action menu go to Unlock for write to device.  

- Enter the user password and press OK. (default: ef56) 
- On the IO Config Edit tab go to Edit Device and then Open Configuration in device 
 

The configuration is loaded and all settings are displayed on the IO Config Edit tab. 
 

- Open the list with inputs for a device with the + to the left, see Figure 13  

- Select new sensor type on the drop-down menu  
- Write a Comment for the new sensor, this name is what will be showed in the Data source.  
- On the IO Config Edit tab go to Edit Device and then Save Configuration in device, the unit 

will reboot. 
 
Note that the Sensor Type list is common for PA Pro III and R560 but the analog inputs on the PA 
Pro III can’t handle Pt1000 sensors. 
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Figure 13  
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11 Basic Functions of the Software 
The chapter describes basic functions of the Climacheck Software. For more detailed information, 
please refer to the Software Manual. 
 

11.1 Tabs 
The tabs contain different data and ways to display it. 
 

 

Figure 14 

 

• Description – Information about the measured system entered by the user. Not directly 
used by the program. 

• Report – The standard tab containing current and previous data in a chart. 

• Constants – Contains constants that can be modified by the user. 
• Input – Shows the data supplied by the sensor. Convenient when troubleshooting the 

attachment of the sensors. 
• Custom – Compare how the system runs before and after your adjustments. To select a 

reference point right-click on the row in the Report tab and select Copy to CustomSheet. 
• Flow chart – Displays a flow chart overview of the system. 
• Graph-tabs – Two tabs showing graphs over the systems values varying over time. 

11.2 Choosing refrigerant 
When starting the refrigerant will often be set to R134A automatically. To choose another 
refrigerant go to the menu Refrigerant. Always make sure the correct refrigerant is selected 
before starting the measurements. 
 

 

Figure 15 

11.3 Choosing measuring interval  
You choose how often measurements should be retrieved by selecting a value in drop down menu 
to the right of Scanning. On site 5 seconds is usually a good value, but if you are going to leave it 
for a time it is often better with 60 seconds. 
 

 

Figure 16 
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11.4 Starting the measurement 
To start collecting data from the PA Pro click the Start button in the upper left corner. Scanning is 
shown against a green background and the logging starts automatically. To stop press the same 
button again. 

 

Figure 17 

11.5 Printing the results 
Start by selecting the tab you want to print and then choose File and Print. Start the printing by 
clicking Options. To print the flow chart you need to choose Print Flowchart directly under File. 

(Figure 17) 

11.6 Exporting the results 
Export your results to a file by selecting File and Export. You can choose among Excel, XML and 
ASCII. (Figure 17) 

11.7 Saving 
Save your data by selecting File and Save ClimaCheck Workbook. You can also save your 
changes as a new template by selecting File and Save ClimaCheck Workbook as Template. 
(Figure 17) 

11.8 Emptying the database 
Empty the database by clicking the Clean up button. (Figure 16) 
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11.9 Adding offsets 
When a temperature sensor is used with an extension cable, an extra resistance is added. This has 
to be compensated for in the software, by adding an offset to the measured value. 
 
In the ClimaCheck software, choose the Input tab in the Workbook and enter the offset of the 
extension cable in Kelvin (a positive value). The fields in question (depending on which cables have 
been extended) are marked in red below: 
  

 

Figure 18 
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12 Configuration of Power Meter PowerScout 3HD 
This section explains how to change the most common settings on the PowerScout 3HD. 

12.1 Configuration of CT type 
The PowerScout 3HD can be used together with 150A current clamps and Rogowski coils. To change 
the CT type, the power meter should be accordingly configured as follows: 
 

• Connect the PowerScout 3HD to the computer via the provided USB cable. 
• Open a browser and go to 169.254.1.5. 
• Leave the Password field empty and click on Login. 

 

 

Figure 19 

• Click on Meter Setup 

• Adjust the Type, Range and Phase Shift: 
o For Rogowski coils: 

▪ Type: Rogowski 

▪ Range: 4000 
▪ Phase Shift: 0 

 

 

Figure 20 

o For 150A current clamps: 
▪ Type: millivolt 
▪ Range: 150 
▪ Phase shift: 2.05 
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Figure 21 

o For 50A snap on clamps: 
▪ Type: millivolt 

▪ Range: 50 
▪ Phase shift: 1.02 

o For 20A snap on clamps: 
▪ Type: millivolt 
▪ Range: 20 
▪ Phase shift: 1.11 

• Click on Send Setup To Meter 

12.2 Changing Modbus address 
Each power meter and other Modbus units (such as portable R560) has a Modbus address. When 

connecting more than one power meter each power meter needs a unique Modbus address and it 
might be necessary to change the Modbus address of the power meter. 
 

• Connect the PowerScout 3HD to the computer via the provided USB cable. 
• Open a browser and go to 169.254.1.5. 

• Leave the Password field empty and click on Login. 
• Click on Comms Setup 

• Click on Read Comms Setup From Meter. 
• Adjust the address. 
• Click on Send Comms Setup To Meter. 

 

 

Figure 22 
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13 Configuration of Power Meter EP Pro Scout 
This section explains how to change the most common settings on the EP Pro Scout. 

13.1 Configuration of CT type 
The EP Pro Scout can be used together with 150A current clamps and Rogowski coils. To change the 
CT type, the power meter should be accordingly configured as follows: 
 

• Install the ViewPoint software found on the USB memory. 
• Connect the EP Pro Scout to the computer via the provided USB cable. 
• Launch the ViewPoint software. 

• Select the correct PC COM Port which states “DENT USB” 
• Click on the “Connect” button. The model number and the firmware version of the EP Pro 

Scout will be shown. 

 

Figure 23 

 

• Move to the “Meter Setup” page and click on “Retrieve Meter Setup”. 
 

 

Figure 24 
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• Adjust the line frequency if required. Americas and parts of Asia use a frequency of 60Hz. 
• Adjust the CT type: “RoCoil” for Rogoswki coils and “Millivolt CT” for current clamps. For the 

150A current clamps provided, the “CT Amps” should be set to 150 and “CT Phase Shift” to 
1.1, as shown in the figures below. For the 20A split cores, the “CT Amps” should be set to 
20 and “CT Phase Shift” to 0.75. 

• Click on “Send Setup to Meter” when finished. 

 

 

Figure 25 
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13.2 Resetting energy count 
EP Pro Scout records and reports measured energy. This value will continue to increase with each 
use of the meter. If you want to reset this value back to zero, follow the steps below: 
       

• Install the ViewPoint software found on the USB memory. 
• Connect the EP Pro Scout to the computer via the provided USB cable. 
• Launch the ViewPoint software. 
• Click on the “Connect” button. 

• Move to the “Read/Write Registers” tab and click on “Clear Totals” as shown below. 
 

 

Figure 26 

  



 

Field Manual PA Pro III – 2021-07-08  Page 37(37) 
 

14 Standard content of the PA Pro case 
The table below shows the standard content of the PA Pro case. 
 

Part Amount 

PA Pro panel (mounted in case) 1 

Power supply 24 VDC 1 

USB A to B cable 2 

PowerScout 3HD (Power Meter) 1 

Current clamp/Rogowski coil 3 

Voltage cable 1 

Voltage clamp 4 

Short serial cable for power meter 1 

Long serial cable 1 

Pt1000 Temperature sensor 8 

Pressure sensor 10 bar 1 

Pressure sensor 35 bar 1 

Cable for pressure sensor 2 

Heat transfer paste 1 

Aluminium tape 1 

Insulation tape 1 

Insulation sheets 2 

Clips for insulation 4 

Extra fuses 1 A 10 

USB flash drive 1 

GPRS Antenna 1 

 
 
Always packing the same way makes it easy to quickly check that all sensors are packed and avoid 

coming to site with an incomplete set of equipment. 

 

Figure 27 


